PENNSTATE

s College of Agricultural Sciences

Computer Best
Practices




Alternative Format Statement

This publication is available in alternative media upon request.

Statement of Non-Discrimination

The Pennsylvania State University is committed to the policy that all persons shall have equal access to
programs, facilities, admission, and employment without regard to personal characteristics not related
to ability, performance, or qualifications as determined by University policy or by state or federal
authorities. It is the policy of the University to maintain an academic and work environment free of
discrimination, including harassment. The Pennsylvania State University prohibits discrimination and
harassment against any person because of age, ancestry, color, disability or handicap, national origin,
race, religious creed, sex, sexual orientation, or veteran status. Discrimination or harassment against
faculty, staff, or students will not be tolerated at The Pennsylvania State University. Direct all inquiries
regarding the nondiscrimination policy to the Affirmative Action Director, The Pennsylvania State

University, 328 Boucke Building, University Park, PA 16802-5901; Tel 814-865-4700/V, 814-863-
1150/TTY.



Table of Contents

MaintainiNg YOUE COMPULET .ccciiiiiiiiiiiiiiiiiieieieeeeeee ettt ee e et e e e e e e e e e e e eeeeeeaesesesesesesassssssssssssssanansnsnannnnnnnnnnnnns 2
Fre@ing UP DiSK SPACE ..viiiiiuiiiiiiiiiee ittt ettt e e ettt e e ettt e e s satae e e sbteeeesabaeeeeantaeeesstaeessnsaeeessnseeeesnes 2
RUNNING DiSK ClEANUP ...tiiiieiiie ettt ettt e e e e et e e s ae e e st e e e e saateee e sbeeeessaseeeeanssaeeennseens 2
REMOVING Old PrOZIamS.....uueieeiiiicciiiieee e e e ettt e e e e eeecttreeeeeesesestataeseeaesesnstaaaseeeesassstasaeaeessanssreeseeaanans 3

Y oJeTe [T Y= O o Yo ol cI (ol D | - PRSP 4
RUNNING CRECK DISK .ttt ettt e e e e e et e e e e e e e e st b e e e e e e e eesanstaaeeaeessensssaeaeaaaanns 4
RUNNING DisSK DEfIagmMENtOr ..ccii ittt e e e e e e e e e e et be e e e e e e e e astaaeeeeseeenannraaeeaaanas 4
SPEEING UP the BOOT PIrOCESS ...vveiiieiciiiiiiee ettt ettt e e e e e e ettt e e e e e e e s antr e e e e e e e seaasbeeeeeesesnnreaneaaenan 5
Cleaning OUL STArtUP FOIAEIS ...uuiiiiei e e e e e e et e e e e e e e s rnabe e e e e e e e eennrneeees 5

TSIy KoY =Y <{=I @] o [ ] o -SSR 6
1Y AV o Yol U T4 01T o} £ 6

[ Tor=1 B o Yol U T4 o T=1 o X £ PP PRSP 6
Temporary Storage of Presentation FilS.........uiii it 6
Temporary Storage of INSLAlEr FIlS .....couviii i e e e e s 6
WeEDbSITe Files and FOIARIS ...ciiiiiiiee ittt sttt te e s be e s be e sabe e srbaesbaeesaseesabeeeneas 7
Archived OULIOOK EM@il FIlES (PST)uuuuiiiiiiiiiiriiiieeeeeeiiiireeee e eeeeiteee e e e e eeeirreeeeeeeeenasbraseeeeseesssssreseeeesesnnns 7
FIlEMAKET DAtabases ....cccueiecuiririieiiieiiee ettt et e ettt ste e s te e ebte e sttt e sateessbeesssbeesabeesabeesseaessseesseeensenan 7
PEISONAI DAtA...ueiiiuieiiiieiiit ettt ettt st e ettt e st e e s bt e s be e s bt e e sttt e s be e e bae e ate e s beeeteeebteeaatee e baeeae sabeeebaeens 7
COUNLY SEIVEE SNAIE FOIURI ...uvviieiiee ettt e e e ee et e e e e s e e e aba e e e e e e e e s nabareeeeeseennsrraseaeenas 8
SRAIEPOINT L.ttt ettt ettt sab e st e s bt e sttt e s bt e s bt e e be e e a b e e s beeebe e e bt e e sabee st sbbeesabeenateas 8
Understanding the BACKUP PrOCESS ......ueeiiiiiiiiiiiiieeeeeeccitteeee e eeeervee e e e e e eeetaraeeeeeeeestaraaeeeeeesnsssrasaeeeessnnssnns 8
What Data Gets Backed Up and WHEN........uuiiii ettt eectrre et e e e eetbare e e e e s eettaaeeeeeeeesanraneeeas 8
County Server Share Folder and MY DOCUMENTS ......eieiieiiiiirieeeeeeeeciireeeeeeeeeeirreeeeeeeeesnrrseeeeeeeenasarees 8
[T or= 1 I o Yol U 11 o 1= o X £ SRR 9
Personal Data Folder and Other LOCAtioNS ........ccuiiiiciiiiiiiiie ettt eee e s e et e e e 9
RESTONING DAt ..eeiiiiiiiiiiiiee ettt ettt e e s ettt e e e e e s bbb teeeeeseasasbbeeeeeeeesannbbbeeaeeesan seeeaeeanan 9
Understanding the MicroSoft Update PrOCESS ......ciivciiiiiiiiiieiiiieeeeiiiee sttt e sttt sae e s s sree e s sre e e e snaeeeessnes 9
What are MIiCroSOft UpPAates ... ..ciiiiiiieiiiiiie ittt e e sbee e s s ate e e s sbee e s essbeeesssteeeesanenas 9
How Do EN Computers Get the Microsoft Updates........ccceeeeieeciiiieei e 10
How Do Non-EN Computers (such as Home Computers) Get the Microsoft Updates ..........cccueeeneeee. 10
Configuring AULOMAtIC UPAates..cccc it e e et e e e e e et e e e e e e s rnnrneneeas 11
ManNUAllY UpAating ...ttt e e e e e e e e e e e e e s e e e e e e e e sanbtaaeeeeesennnsenneeeseesnnns 11
Understanding Re-Directed My Documents and Offling Files.........ueeveiieecciiiieeei e 12
WoOrking Offling — TIPS & TIICKS .uviiiiiiieeiciiie ettt e e tee e e srate e e e e bae e e seataeeesrtaeeesnraneeenes 12
UNderstanding USEr ACCOUNTES .....uuuiiiiiiiiiiiiiiieeee e s essiie e e e e e e sstaree e e e e sesaabeeeeeesessastaneeeeessansssennesssessssssnnnens 13
Which Account is USed fOr WHat? ........uiiiiiiiiiiiieeriee sttt et st siae e s e e st esae e e sebeesnes 13

(0 T aT=d o Tl o T Ny T o [ SRURR 14
PSU ACCOUNT (FUII ACCESS) veveeieeieiiiiiiieee e eeetteee e e eeetrte e e e e e eeearaeeeeeesesatbsaeeeeeeeessabsseeaeessasnsssseeeasenans 14

FPS ACCOUNT ...ttt st e e e s e et e e e e s s s bbbt e s e e s s e nnbeateees srnnaeeas 14
College Of Ag SCIENCES ACCOUNT....ccuuiieeiiiiie ettt e ettt e e ettt e e sre e e e staeeessabaeeestbeeesassaeeesssaeeeansseeeessneeans 14

Y Yo T T=dT o = =12 0 T 11 USSR 15
Checking MailDOX SIZE ....uviiiiiiiie ettt e e et e e s et e e e s e abe e e e ebteeeesabeeesennbaeeessteeeennraeas 15
e [N o g Y=Y 1] oY Y ISR 15
Moving Messages t0 LOCAl STOMAZE ......uiiiiiiii ittt e e e e s srbe e e s sbee e s eaaes 16

Understanding the SPam FOIEIS .....uuiiiiiiiie ettt e e st e s e e s s ebe e e ssaaaeeeas 16



2] T Yo (Yo Y= g Yo L= 3l o] o [T PSR 17

(O TUE =T o YT o TSI o] [ [T RN 17
ReCOVEIiNG @ DEIETEA IMIESSAZE .....uvvvieeieeeieiiiiieeeeeeeeiittreeeeeeeeeeibreeeeeeeessabareeeeeseesstsrasaseseesssssrssaeeeesennnsens 17
Locking vs. Logging Off vs. SNULLING DOWN.....coiiiiiiiiiiie ettt e e e e e sbee e e e nre e e e 18
(ool (1 V-SSR 18

(o T=4 4 1o Y O & PRSI 19

Y 210kl Y=g B LY o PSRRI 19
Recommendations ChECKIiSt...........uiiiiiii e e e e re e e e e e e et br e e e e e e e e ennrraaeeas 20
Daily (End of work day Monday — TRUISAAY)........ueieeiiiieeeieee ettt ettt eeeae e e e eare e e e enre e e e nnaee s 20
WWEBEKIY ettt e e e e e et a e e e e e e e ee et e teeeee e e e e e abraaeeeaeeaantraaeaeeeeaaannte aeeeanrrrareeaaaaans 20
Vo] oYl oY1 USSR 20
QuArterly or Bi-IMIONTNIY ..ot e e e e et e e e e e e e s eeabrbae e e e e e eenanrraaaeeas 20



Maintaining Your Computer

To keep your PC performing well, regular maintenance is critical. By following a few simple guidelines,
you can maintain your computer and keep it running smoothly.

Freeing Up Disk Space

Freeing up disk space can improve the performance of your computer. Over time, temporary files are
left behind when you browse the Internet, your machine crashes, you install and uninstall programs, and
various other circumstances occur. These temporary files take up space and may slow your computer.

Windows XP provides a tool called Disk Cleanup that helps you delete unnecessary files, freeing storage
space on your computer, and keep it running efficiently. During Disk Cleanup your hard drive is scanned
for files that can safely be deleted and you are given the option to keep or delete them.

RECOMMENDATION: We recommend you use Disk Cleanup quarterly or every other month.

Running Disk Cleanup

1. Before running Disk Cleanup close all other programs
2. Click the Start menu | All Programs | Accessories | System Tools | Disk Cleanup
3. Select the drive you want to clean and click OK. In most cases this would be C:
» Disk Cleanup will analyze the drive to determine space that can be freed. Be patient as
analyzing the drive can take awhile depending on your hard drive size and contents.

» Once the drive analysis is complete a “files to delete” list will be presented for your
selection. A description of the category is shown at the bottom if you click the name.
4. Inthe Files to delete list, check or clear categories as desired

RECOMMENDATION: The following categories of files can safely be removed:

Temporary Internet Files

Offline Webpages

Recycle Bin

Temporary files

WebClient/Publisher Temporary Files
Compress old files

Catalog files for the Content Indexer

. NANANENRN

The following categories of files SHOULD NOT be removed:

v" Downloaded Program Files
v'  Temporary Offline Files
v’ Offline Files

5. Click OK to delete the files
6. Click Yes to confirm you want to perform the cleanup actions
7. Click OK

A video demonstration of how to run Disk Cleanup is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/diskcleanup
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Removing Old Programs

Frequently, users have programs installed on their computers that they do not use or need. Sometimes
these programs get installed automatically when other programs are installed. Other times these are old
programs that were once used, but are no longer needed.

Programs you do not use can easily be uninstalled to free up disk space and improve the overall
performance of your computer. To uninstall programs:

Click the Start Menu

Click Control Panel

Select Add or Remove Programs

Some programs that are often installed but not needed include:

PN PE

e Google Earth, Google Desktop, Google Toolbar

e  WinAmp

e Logitech Desktop Messenger

e Logitech (if old software, remove all — then install new)

e Spybot, Spyware Blaster, Ad-Aware, Windows Defender

e Webshots

e Yahoo programs (Yahoo Toolbar, Yahoo Installer, Yahoo Mail)

e AOL or AIM programs (AOL or AIM Toolbar, AOL or AIM Installer)
e Viewpoint programs (Viewpoint Toolbar, Viewpoint Player, Viewpoint Manager)
e Old versions of Java

e Weather programs

5. Click the program to be removed
6. Click Change/Remove or Remove
7. Click OK if prompted to confirm the uninstall

If you are not sure what a program is or if it should be removed, please submit a support ticket at
http://it.cas.psu.edu/contactform.htm and provide the name of the program in question.

A video demonstration of removing a software program is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/Removelava
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Speeding Up Access to Data

During normal use your computer’s hard disk can develop bad sectors, lost clusters, and directory errors
and/or become fragmented. This forces your computer to work harder to locate or save files and may
cause it to run more slowly.

Running Check Disk

Windows XP provides a tool called Check Disk that will scan your hard disk, locate errors, and ask if you
would like to fix them. A disk check will take anywhere from 30 minutes to 2 hours depending on the
size and speed of your hard drive and the number of errors that are found. You will not be able to use
any other programs while the disk check is running so you should run it when you don't need to use your
computer for a while.

RECOMMENDATION: We recommend you use Check Disk quarterly or every other month.

Before running Check Disk close all programs

Click the Start Menu

Select My Computer

Right-click on Local Disk (C:) and choose Properties

Click the Tools tab

Click Check Now

Check the Automatically fix file system errors box

Check the Scan for and attempt recovery of bad sectors box

Click Start

> You will see a window saying that the disk check must be done when you restart your

computer.

10. Click Yes

11. Click OK

12. Click the Start Menu

13. Click Shut Down

14. Select Restart from the menu

15. Click OK

LN A WNR

Once your computer restarts you will see a blue screen as Check Disk begins analyzing your hard disk. It
will go through five separate stages, allowing you to monitor its progress as it works. After Check Disk
finishes all of its tasks, it will automatically restart your computer and you will be able to log on and
continue working.

NOTE: It is OK if the Check Disk discovers a few errors. But, if it comes up with hundreds of errors, the
drive may be failing and you should submit a support ticket at http://it.cas.psu.edu/contactform.htm.

Running Disk Defragmenter

Your computer’s hard disk becomes fragmented as you browse and download files from the Internet,
create and delete files and folders from your computer, and install and uninstall software. Fragmented
simply means a file is not stored in one place in its entirety, or what computer folks like to call a
contiguous location. Different parts of the file are scattered across the hard disk in noncontiguous
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pieces. When you delete files or folders, the empty spaces left behind are filled in randomly as you store
new ones. This is how fragmentation occurs. The more fragmented files there are on a computer, the
slower the computer will be.

Windows XP provides a tool called Disk Defragmenter designed to reorganize noncontiguous files into
contiguous files and optimize their placement on your computer.

RECOMMENDATION: We recommend you use Disk Defragmenter quarterly or every other month.

Before running Check Disk close all programs

Click the Start Menu

Select My Computer

Right-click on Local Disk (C:) and choose Properties

Click the Tools tab

Click Defragment Now

Click Analyze

If defragmentation is found, Defragment the drive

> Disk defragmentation may take several minutes to several hours, depending on the
number of files to be consolidated.

N kWM

Speeding Up the Boot Process

Many programs installed on your computer include a component that loads every time you start your
computer. For instance, when you install an instant messaging program, a shortcut is added to your
Startup folder that launches the instant messenger automatically. The more programs automatically
starting when your computer boots, the slower the startup process will be. The easiest way to speed up
your computer’s boot process is to weed out unneeded items from Startup folders.

Cleaning Out Startup Folders

Click the Start Menu

Click All Programs

Right-click Startup

Select Open

Delete all the files within the Startup Folder EXCEPT desktop.ini, if it exists.
Click the Start Menu

Click All Programs

Right-click Startup

. Select Open All Users

10. Delete all the files within the Startup Folder EXCEPT desktop.ini, if it exists.

©oONOUEWNE

Cleaning out your Startup folder will not necessarily prevent all unnecessary programs from
automatically running at startup. There are more complicated steps that can be taken to remove
programs from startup, but we do not recommend you perform these steps on your own. If you find
that your computer still starts very slowly, we recommend that you submit a support ticket at
http://it.cas.psu.edu/contactform.htm and a support specialist will assist you.
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File Storage Options

Users have a variety of locations available for storing work related files. While having many choices is
nice, it can also be confusing. It is important that you understand what storage options are available;
what types of files are best stored in each location; and how, when, and from where files stored in each
location can be accessed.

My Documents

The My Documents folder can be used to store work related files. This folder is special in the way its files
are stored and made available to you.

Your My Documents folder and the files within it will be available from your computer AND from other
EN computers within your “home” county office AND from your computer when you are out of the
office (in the case of a laptop). This is possible because your My Documents folder is “redirected”.

So what does it mean to be redirected? Well, in short it means that the files in your My Documents
folder are saved (redirected) to your county server and a copy of them is made in a special location on
your local computer. When your computer is offline (disconnected from the network), you are able to
work with the copy of the files that is stored on your local computer. This is what we call “working
offline” and is what allows you to work with your My Document files when you are out of the office
(offline) or when you are logged into another EN computer in your home office. A more detailed
explanation of “Re-directed My Documents” is available later in this guide.

Your My Documents folder is backed up daily as part of your county server backup.

Local Documents

The Local Documents folder is another location where you can store work related files. Unlike the My
Documents folder, which is redirected to the server, the Local Documents is a folder stored right on your
local computer.

This folder is found just off of your computer’s C:\ drive and a shortcut to the folder should be available
from your desktop. Files placed in the Local Documents folder are accessible to you when you are logged
into the computer. Other users who log into your computer will have the ability to see the files but not
edit them in any way. The Local Documents folder is backed up daily as part of your computer backup.

We recommend you use the Local Documents folder in certain instances, such as those described below.

Temporary Storage of Presentation Files

In the normal course of the day, you may create and save files into your My Documents folder. When
you take your EN laptop out of the office (and off the network), these files will still be available as you
“work offline” from your redirected My Documents. In the unlikely event that Offline Files would fail,
before leaving the office, you could copy files to the Local Documents folder. This is something you
might want to do if you were taking your laptop out of the office to deliver an important presentation
and you wanted to ensure the presentation files would be available.

Temporary Storage of Installer Files
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Ag IT understands that at times you may need to install additional software on your EN computer. Often
you will download Software installer files from the Internet and save them to your computer for
installation. The Local Documents folder is where we recommend you store installer files. You can create
a "Downloads" or "Installers" folder in Local Documents. If you need or want to keep the installer file,
perhaps to re-install later if you purchased the software online and don't have a physical media (CD or
DVD), you can leave it in the folder. Otherwise, it is a good idea to delete the installer file after you have
installed the software.

Website Files and Folders

If you are responsible for maintaining your county website, you need a location on your computer to
store website files and folders. Instead of the redirected My Documents folder, we recommend you
store website files in Local Documents. To keep everything organized, you should create a “Website”
folder within the Local Documents folder to hold all of your website files.

Archived Outlook Email Files (PST)

As you collect emails in your Outlook Exchange account your mailbox size grows and grows. As your
mailbox grows you may find that your Outlook slows. To prevent this, we recommend you move old
emails that you do not need to use regularly out of your Outlook Exchange account into an Outlook
Personal File (.PST). Once created, PST files need to be stored in an easily accessible location, such as
your Local Documents folder.

FileMaker Databases

Opening and using mission-critical FileMaker (FMP) files from a network location is NOT recommended.
Instead, FMP files should be stored in your Local Documents. Why? The answer is that FileMaker is very
dependent on being able to write (save) its data to disk as needed. FileMaker does not have a "Save"
command. It saves automatically when the computer is idle. If you are using a FileMaker database from
a network share and the network is down when it attempts to save, the file will crash and may become
unrecoverable.

Personal Data

The Personal Data folder can be used to store any non-work related files that you need to keep on your
work computer. It is important that you keep these files to a minimum.

The Personal Data folder is found just off your computer’s C:\ and a shortcut to the folder should be
available from your desktop. Files placed in your Personal Data folder are only accessible to you when
you are logged into the computer. Other users who log into your computer will have the ability to see
the files but not edit them in any way.

The Personal Data folder is NOT backed up automatically. If you would like to have your personal data
backed up, you will need to do it manually. For instructions on how to manually backup your personal
data, visit the Ag IT How To’s, http://it.cas.psu.edu/921.htm, http://it.cas.psu.edu/919.htm, and/or,
http://it.cas.psu.edu/920.htm. A video demonstration of backing up personal data is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/backuppersonal.
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County Server Share Folder

Each county server has space that has been allocated as “shared” storage space. This space can be used
to store files that need to be shared with others in the county office. From within your county’s share
folder you can:

e Open/read shared files and folders

Copy files from the folder to your Local Documents or My Documents folder

Create new folders

Copy files from your Local Documents or My Documents folder into a County Share folder

Files stored in the Server Share folder are available from any computer within the office and all county
office employees have access to the files. These files cannot be accessed from outside the office or by
employees from other county offices. The only exception to that rule is multi-county educators. Multi-
county educators can access the County Share folder from their secondary county office if they request
their account be configured in that way. Video demonstrations related to using the County Server Share
are available at: http://downloads.cas.psu.edu/it/training/bestpractices/archiveonserver,
http://downloads.cas.psu.edu/it/training/bestpractices/savepictures,
http://downloads.cas.psu.edu/it/training/bestpractices/accessinggroupfiles, and
http://downloads.cas.psu.edu/it/training/bestpractices/serveraccess.

SharePoint

A SharePoint site is another option available for file storage. We would recommend SharePoint as a
location for storing files that are to be shared with other users. This would be an alternative to using
your County Server Share folder.

Unlike your County Server Share folder, files saved on a SharePoint site are accessible when you are not
in the office. In fact, files within SharePoint are available from any computer that has Internet access.
Another advantage of SharePoint over the County Share folder is that you are not limited to sharing files
exclusively with users from within your county office. Users from any office or department, as well as
individuals outside of PSU, can get access to files stored on a SharePoint site.

Each Region and County has their own SharePoint site. Additionally, SharePoint sites can be created for
program teams or special project teams. To find your region or county SharePoint site, visit the main
Cooperative Extension SharePoint site at http://sharepoint.ag.psu.edu/coext and select either your
Region tab or the County tab across the top of the site. For information on having a SharePoint site
created, please submit a support ticket at http://it.cas.psu.edu/contactform.htm and a support
specialist will assist you.

Understanding the Backup Process

What Data Gets Backed Up and When

All of the files saved in your County Server Share Folder, My Documents, Local Documents, and
SharePoint are backed up regularly.

County Server Share Folder and My Documents
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The County Server Share folder and your My Documents folder (because they reside on your server) are
backed up each night when your server backup runs. This occurs around 11:30 PM each night.

Local Documents

Your Local Documents and your Profile, which contains your Internet Favorites and some necessary
application settings, are backed up each night (Monday through Thursday) at 10:00 pm and 10:30 pm,
respectively. Each of these backups typically takes less than 20 minutes to complete.

In order for your Local Documents and Profile to be backed up your computer MUST be in the office,
connected to the network, and turned on.

RECOMMENDATION: At the end of your work day (Monday — Thursday) log-off your computer (Start
menu, choose Log Off) and the backup processes will run automatically at the designated time. NOTE: You
may choose to Shutdown if storms are threatening your area or over weekends. A video demonstration of
logging off is available at: Hhttp://downloads.cas.psu.edu/it/training/bestpractices/logoffnightlyH.

If you are a laptop user and regularly take your computer out of the office at night, you should arrange
to leave it at the office, connected to the network, and logged off at least once a week*. This will ensure
that once a week your data will be backed up properly.

*Because of additional maintenance that automatically occurs on EN computers, if you are only able to
leave your laptop in the office one day a week, Mondays or Thursdays would be our recommendation.

Personal Data Folder and Other Locations

Files stored in your Personal Data folder or other locations on your computer are NOT backed up. Itis
your responsibility to manually back up any additional data you need. For instructions on how to backup
your Personal Data, visit the Ag IT How To’s, http://it.cas.psu.edu/921.htm,
http://it.cas.psu.edu/919.htm, and/or, http://it.cas.psu.edu/920.htm. A video demonstration of backing
up personal data is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/backuppersonal.

Restoring Data

In the event of lost or damaged files from any of the backed up file locations (County Server Share
Folder, My Documents, Local Documents, and SharePoint), please submit a support ticket at
http://it.cas.psu.edu/contactform.htm and a support specialist will assist you in restoring the files.

Understanding the Microsoft Update Process

What are Microsoft Updates

After Microsoft releases software, problems are uncovered and solutions are developed. The solutions
to the problems are released to the public as updates. Some of the discovered problems are serious
flaws that can allow hackers access to your computer and the other computers on your network. It is
important that computers have the necessary updates installed in a timely manner.
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How Do EN Computers Get the Microsoft Updates

The Ag IT Department reviews Microsoft Updates as they become available, to determine if and when
they should be installed. Once the Ag IT Department determines an update is necessary and will not
conflict with other EN software programes, it is released for download. Around 3:00 AM every morning,
EN computers that are turned on and connected to the network will download and automatically install
any updates released by the Ag IT department.

EN computers that are not left on overnight will download and install the updates the next time they are
in the office and on the network.

RECOMMENDATION: At the end of your work day log-off (Monday — Thursday) your computer (Start menu,
choose Log Off) and the Microsoft Updates will run automatically at the designated time. NOTE: You may
choose to Shutdown if storms are threatening your area or over weekends. A video demonstration of
logging off is available at: Hhttp://downloads.cas.psu.edu/it/training/bestpractices/logoffnightlyH.

At times, you may receive a notification in the System Tray (lower right corner of your screen) related to
Microsoft Updates. This would indicate that the update process did not complete the previous night.
This can happen for a variety of reasons, such as:

e You locked your keyboard instead of logging off, preventing updates from running or the
computer from rebooting after the updates.

e Computer processes hung during log off, preventing updates from running or the computer
from rebooting after the updates.

e There were a series (multiple updates in a row) of updates to be installed and a
reboot was required between the updates.

The notification will appear as a yellow shield with a black exclamation point inside, as
shown on the right. A video demonstration of a notification and corresponding action is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/windowsUpdate.

In most cases, this notification will be informing you that an update was installed and that your
computer needs to be restarted. In other cases, you may find that the notification indicates an update
still needs to be installed. In either case, you will need to restart or install the update as soon as
possible. If you ignore the notification, the alert icon will continue to display and computer will be
sluggish as it expends processing power keeping track of the updates.

EN computers are configured to automatically download the updates released by Ag IT. Users should
NEVER download and manually run updates from the Microsoft Windows Update website on an EN
computer.

How Do Non-EN Computers (such as Home Computers) Get the Microsoft Updates
NOTE: This information is for Non-EN Computers ONLY!

Ag IT manages the Microsoft Updates for EN computers, but it is important for all computers to be
updated. Non-EN computers (such as home computers) can be configured to download and install the
updates automatically at a regularly scheduled time or they can manually be downloaded and installed.
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Configuring Automatic Updates
To configure a non-EN computer to receive automatic updates, do the following:

Click the Start Menu

Right-click on My Computer

Choose Properties

Click the Automatic Updates tab

Select the Automatic radio button

Select the desired frequency and time options
Click OK

NouswnNRE

Once a computer has been configured to receive automatic updates, you can go about your day working
as usual. At times, you may receive a notification in the System Tray (lower right
corner of your screen) related to Microsoft Updates. The notification will appear as a
yellow shield with a black exclamation point inside, as shown on the right.

In most cases, this notification will be informing you that an update was installed and that your
computer needs to be restarted. In other cases, you may find that the notification indicates an update
still needs to be installed. In either case, you will want to restart or install the update as soon as
possible. If you ignore the notification, the alert icon will continue to display and your computer will be
sluggish as it expends processing power keeping track of the updates.

A video demonstration of a notification and corresponding action is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/windowsUpdate.

Manually Updating
To manually update a Non-EN computer, do the following:

1. Open Internet Explorer
2. From the Tools menu choose Windows Update
» The Welcome to Microsoft Update page should display. If it does, go to Step 3. If you are

asked to update to Microsoft Update, please follow the prompts to do so and then, go to
Step 3.

To scan for high priority (critical) updates, click Express

If updates are NOT found, close the browser window and you are finished

If updates are found, click the Install Updates button

Wait while the updates are downloaded and installed

If you are asked to Restart the computer, please do so; otherwise, click Close

Nouk~Ww

Note: If you were asked to restart the computer, repeat Steps 1 - 6 until all the high priority/critical
updates are applied (no updates are found in Step 4).
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Understanding Re-Directed My Documents and Offline Files

As mentioned earlier in this guide, your My Documents folder is special in the way its files are stored
and made available to you. You will often hear this described as “Re-directed My Documents”.

Re-directed My Documents means that your My Documents files are saved (redirected) to your county
server. In addition, a copy of your My Documents is stored in a special location on your local computer.

When you are in your home office and a network connection is present, the two copies will be kept in
sync. Throughout the day, at any point your computer is idle for 15 minutes, a “Quick Sync” occurs.
When you log on and off your computer a “Full Sync” occurs.

The Quick Sync in designed to be... quick. It may not, at all times, keep the local copy and the server copy
in complete sync, so it is important that a Full Sync occur each day.

Assuming a Full Sync has occurred, when your computer is taken offline (disconnected from the
network) you will have access to all of your My Documents via the copy that is stored on your local
computer. This is what we call “working offline” and is what allows you to work with your My Document
files when you are out of the office and/or a network connection is not available.

What makes this process possible is the Windows Offline Files feature which uses something called an
“offline file cache”. While you don’t need to know all the details of how this feature works, it is
important for you to know a few things.

1. When there is no network connection available, you are working offline and the offline file
cache takes over. This simply means that your My Documents folder is reading from your local
copy of files rather than from the server.

2. When there is no network connection, you will i) Offline Files - Working offline
see a message that you are "Working Offline". You are no longer :mh;ted to 'AG.PSLLEDLS. You can
o . . continue working normally,
This is OK. You can work with the files the same Click this mn}:q\,,m Eing

way that you work with them when you are
connected to the network. When you reconnect
to the network, changes that you made to the "local" copies will synced to the server.

3. The offline file cache is a copy of your server based files and folders that is stored in a hidden
folder on your local computer. While the server has a large hard drive and provides a great deal
of storage space, you are still limited by the size of your local computer’s hard drive.

Working Offline — Tips & Tricks

Users need to be aware of a few unique situations when working offline.

1. When you are working offline, you can create and delete files and folders and can rename files;
however, you cannot rename folders. If you try to rename a folder, you will see the message
"Cannot rename <foldername>: This operation is supported only when connected to the
server." You must wait for the network to become available before you can rename the folder.

2. As alaptop user, you may be tempted to "just close the lid" to leave the office because that is
quick and easy. But, if you do not log off or shut down, a Full Sync will not occur and you may
not have access to all your My Documents. You should always log off or shut down your laptop
when taking it from the office.
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3. When you turn on your laptop outside your home county office, you do not want the computer
to "see" or sense a network. You want it to recognize that it is offline. To ensure this happens:

a. If your computer has a wireless card, disable it before turning your computer on. When
your computer is turned on, it won't try to connect to a wireless network to for
synchronization. If you need wireless, you can enable it after the computer is turned on.

b. If you are in another office or location with a high speed connection, don't plug in the
network/Ethernet cable before you turn on your computer. Wait for the machine to
boot completely before you plug in the network cable so it does not see the network
and attempt synchronization.

c. Seeing the "Working Offline" message when you are disconnected from the network is
normal and you should ignore the message. Do not try to re-connect or synchronize, you
should be able to work normally from your offline file cache. Once you are back in the
office and connected to the office network, plug in the network cable before you turn
on the computer and the work you did will be synchronized with the server.

Understanding User Accounts

As a College of Ag Sciences or Cooperative Extension employee, you will normally have TWO user
accounts, a PSU account and a College of Ag Sciences account. Your PSU Account is issued by Penn State
at the time you first begin employment. For some employees (Penn State paid), the Penn State Account
is a “full access account” and for others (County paid) the account will be a “limited access account”
often referred to as a Friends of PSU (FPS) account. In either case, the accounts provide a unique user ID
and password that will be used to access Penn State resources.

Once you have been issued your Penn State or FPS account, a College of Ag Sciences account is created.
The College of Ag Sciences account is what you use to log into your computer each day and access
various College of Ag Sciences resources. The user ID for your College of Ag Sciences account is always
the same user ID as your Penn State account. This is done to easily identify account holders.
Additionally, it helps users remember their user ID’s. For the same reason, we strongly recommend that
users maintain the same password for both their Penn State and College of Ag Sciences accounts.

Which Account is Used for What?

At times it can be difficult to understand when you should use your College of Ag Sciences account, as
opposed to your Penn State account. Below is a table that can help.

NOTE: unless noted with an asterisk (*) resources accessible via the PSU account are only available with a full
PSU account and not an FPS account.

College of Ag Sciences Account PSU Account
Log into EN computers Log into campus computer lab computers
SharePoint Log into Adobe Connect Sessions*
Email (College of AG Outlook Exchange) ESSIC (online system for timecards, benefits, etc.)
Dreamweaver/County Website (website admins) | ANGEL*
CASPAR
eCommerce/ePay
VPN
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Changing Passwords

For security purposes, you are required to change your Penn State and College of Ag Sciences account
passwords once a year. However, we recommend that you change your password at least every six
months. If you do not change your password within the required time period, your account will be
deactivated and you will have to take action to have the account reactivated.

RECOMMENDATION: Change your Penn State, FPS, and College of Ag Sciences password at least every six
months.

PSU Account (Full Access)

When a Penn State account is created, it is automatically assigned a temporary password made up of
random letters and numbers. Users are then expected to change the temporary password to something
easier for them to remember. The new password must meet the following guidelines:

It must be at least eight characters in length

It must contain at least one alphabetic and one numeric character
It must be significantly different from the last three passwords

It cannot be the same as your user ID

It cannot start or end with your initials

It cannot include your first, middle, or last name

oukwnNeE

Eight weeks before your password is set to expire, Penn State will begin sending email notification
warnings. It is VERY important that you change your PSU password before it expires. If you do not
change your password and it expires, you will need to physically go to a PSU campus to have your
account re-activated. Your PSU account password can easily be changed at
http://work.psu.edu/password.

FPS Account

When a FPS account is created, you specify the password you would like to use with the account. The
password must be at least eight characters in length and must contain at least one numeric character.

At this time, you are not required to change a FPS password regularly. However, we still recommend it
be changed at the same time you change your College of Ag Sciences password. Your FPS password can
be changed at https://fps.psu.edu/ by clicking the Change Password link.

College of Ag Sciences Account

Similar to your Penn State account, when your College of Ag Sciences account is created, you are
assigned a temporary password that you are expected to change. We STRONGLY encourage users to
make their College of AG Sciences and PSU passwords the same, for easy of remembering them.

Also like your PSU password, your College of Ag Sciences password will expire once a year. We suggest
you change your College of Ag Sciences password at the same time you change your PSU password. You
AG password can be changed at http://work.ag.psu.edu. More information and steps to change
passwords are available from the How To’s area of the Ag IT website, http://it.cas.psu.edu/HowTo.htm.
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Managing Email

The more space your mailboxes take up, the slower your email access will be. This is because of the
time it takes the email system to transfer mail from the server to your computer.

The goal for College of Ag Sciences Outlook Exchange accounts is 250 MB of storage space per user. This
is roughly equivalent to 12,000 Email messages (including attachments and calendar data) in total for all
of your folders. If your storage space goes beyond 500 MB then you may receive a reminder that you
should take action to free up disk space.

Checking Mailbox Size

To determine how much space your mailbox is consuming, do the following:

1.
2.

v

Open Outlook
From the Go menu choose Folder List
o Outlook 2007, click the View menu, select Navigation Pane and choose Normal
Once you can see the Folder List, Right Click on Mailbox - (your name) and select Properties for
Mailbox - (your name)
Click the Folder Size button
Write down the number beside Total size (including subfolders)
This number is total amount of space your Email, calendar, and attachments are using on the
Exchange server
0 This space is listed in kilobytes (KB)
0 To convert this number to megabytes (MB), divide by 1000 for a rough estimate
o0 Ex: 100,000 KB would equal 100 MB
Click Close
Click OK

Reducing Mailbox Size

There are several simple things you can do to reduce or manage your mailbox size.

v Periodically empty the Deleted Items folder (this is a good end-of-the-week task)
v’ Periodically delete items from the Sent Items folder or move to local storage (this is a good
end-of-the-month task)
v' Delete items older than a certain date (i.e. items older than 2 years)
O You can sort your mailboxes by date received or do an Advanced Find to locate
those messages older than a certain date
v File incoming attachments into the proper folder within My Documents and delete them
from the email message
0 Right-click the attachments and select “Save As”
0 Right-click the attachment and select "Remove"
v' Delete attachments from Sent messages
0 Open the sent message, right-click the attachment and select “Remove”
v" Move seasonal or less used message to a local storage folder (See the instructions to Move
Message to Local Storage)

Computer Best Practices 15



Moving Messages to Local Storage

To keep your mailbox size manageable, we recommend you move old or infrequently used items out of
your mailbox into a locally stored personal folder (.PST). We recommend that you store the .PST file in
your Local Documents folder). Why? This file will contain your email and should be backed up regularly.

RECOMMENDATION: Store personal folders (.PST) in your Local Documents folder.

Create a folder called OUTLOOK-PST in your Local Documents folder
Open Outlook
On the Tools menu, click Options
Click the Mail Setup tab
Click the Data Files... button
Click Add
» Personal Folders file (.pst) should be selected
Click OK
Locate and open the OUTLOOK-PST folder you created in Step 1
Edit the file name to be "your UserID".pst. Example: ntv1.pst
10. Click OK
» The next dialog box allows you to set options for encoding the information in your
personal folder (.PST) file. Encryption encodes the file to make it unreadable by other
programs. Password-protecting is optional and provides added security. If you add a
password, you will be prompted for the password when you start Outlook or connect to
the personal folder file, unless you save the password in the password list. We
recommend that you leave the default settings as they are.
11. Click OK
> You will see the "Personal Folders" appear in the Outlook Data Files dialog box.
12. Click Close
13. Click OK
> You will now see a "Personal Folders" folder in the Folder List. To view the Folder List,
from the Go menu choose Folder List.
14. You can now begin moving folders from the "Mailbox - Your Name" list into this folder by simply
clicking and dragging. If you want, you can create Subfolders in the "Personal Folders" folder
first. If you are moving a folder with a great deal of information, please be patient as it moves.

ok wnE
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Note: Please remember that the "Personal Folders" folder data is now on this machine only. You will
not have access to this folder from Outlook Web Access (OWA).

Understanding the Spam Folders

The College of Ag Sciences has a spam filter in place that intercepts a large number of the spam
messages you would receive. This filter is often referred to as “Ninja”.

As email messages are received, Ninja evaluates them to determine the likelihood they are spam. If a
message is found likely to be spam, it is quarantined and not placed into your Inbox. Ninja uses three
folders when evaluating and consequently quarantining messages. These three folders are found within
the Spam folder that is in your Outlook mailbox.
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Allowed Senders Folder

The Allowed Senders folder is used to create a list of email addresses that should NOT be quarantined.
In other words, email message that come from addresses found in the Allowed Senders folder will
always be delivered to your Inbox.

By default, any email address that is found in your Outlook Contact list is automatically considered an
“allowed sender”. However, if you find a quarantined email from a sender you would like to receive
future emails from, but you do not want to add them to your contact list, you can move or copy the
email from the quarantine folder into your Allowed Senders folder. An example of this might be a
listserv to which you are subscribed.

Please note that you must keep email in the Allowed Senders folder for as long as you wish to receive
email from the sender. Once the email is removed from the Allowed Senders folder, email from the
sender may be delivered to the quarantine folder.

Blocked Senders Folder

The Blocked Senders folder is used to create a list of users from whom you do not want to receive email
messages. There is no need to maintain a large list in the Blocked Senders folder since most unsolicited
spam emails are caught by Ninja before they reach your Inbox. However, if you receive messages that
still slip through, simply drop the messages into your Blocked Senders folder and you will not receive
future message from that sender.

Remember, just like the Allowed Senders folder, you must keep emails in the Blocked Senders folder for
as long as you wish to block email from the sender. Once the email is removed from the Blocked Senders
folder, email from that sender may be delivered to your Inbox.

Quarantine Folder

Any email messages that Ninja determines to be spam or messages from addresses that are listed in the
Blocked Senders folder are automatically placed into your Quarantine folder.

On a daily basis, you will likely receive large numbers of spam messages. These messages will
accumulate in your quarantine folder and eventually consume large amounts of space. You will need to
be diligent in keeping the Quarantine folder emptied. We recommend that you delete the messages in
the Quarantine folder on a regular basis (at least once a week) to keep the size of the folder small and
make sure your mailbox is free of spam.

RECOMMENDATION: Delete the messages in the Quarantine folder once a week.

Optionally, you can delete the entire Quarantine folder, erasing all of spam messages in one easy step.
The next time a spam message is quarantined, the system will automatically rebuild the folder and place
the new spam message into it.

Recovering a Deleted Message

Have you ever deleted an email message contact or task, emptied your Deleted Items folder, then
realized you needed the item after all? Wish there was a way to get the message back? Well...there
might be!
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The College's Exchange server keeps items deleted from the Deleted Items folder for 7 days. To recover
these items:

1. Open Outlook
2. Open the Deleted Items folder
3. From the Tools menu choose Recover Deleted Items
» This shows you all of the recoverable items. At this point, all the icons will have the same
generic icon. (i.e. Contacts don't look like contacts, Tasks don't have the task icon, etc.)
4. Highlight the item(s) you wish to recover or click the Select All button
5. Click the Recover Selected Items button (looks like an envelope)

NOTE: This will place the email back into your “Deleted Items” folder. If you want to keep the

message, you will need to move it to your Inbox or another folder.

Locking vs. Logging Off vs. Shutting Down

Locking, logging off, or shutting down your computer are ways to leave your computer. Below you will
find an explanation of each option and suggestions for when you might want to use each.

Locking

Locking your computer keeps all programs open and the network connection active, but prevents
anyone except you or a system administrator from unlocking and viewing any files or programs.

Why would you want to lock your computer? Most simply, to protect your data, instant messages, and
email messages by prohibiting others from using your computer when you are not around.

Locking your computer would be a good idea any time you leave your computer unattended for short
lengths of time. For instance, you could lock your computer when you go to lunch or a meeting.

RECOMMENDATION: Prior to locking your computer, we recommend that you save any documents, files,
messages, etc. on which you are working. This will prevent data loss, in the event of a power outage or
your computer being power off while you are gone.

To lock your computer:

1. Press the Ctrl, Alt and Delete keys at the same time
2. Click the Lock Computer button

..OR...
1. Pressthe Windows and L keys at the same time.

To unlock your computer:

1. Press the Ctrl, Alt and Delete keys at the same time
2. Enter your password
3. Click OK
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Logging Off

Logging off your computer closes all programs, disconnects it from the network, but leaves it powered
on. Like locking your computer, logging off is a good way to protect your private data from access by
others. Unlike locking your computer, logging off is better used when you will be away from your
computer for long periods of time. For instance, it is a good idea to log off your computer when you
leave for the night.

The reason we recommend logging off at night, as opposed to locking your computer, is because locking
does not guarantee that your data will be safe overnight. If Microsoft Updates requiring a reboot are
applied to your machine and it is locked, any open applications would be closed automatically and the
data in them might be lost. Logging off ensures your data is saved.

To Log Off:

1. Click the Start button
2. Click Log Off
3. Click Log Off

A video demonstration of logging off is available at:
http://downloads.cas.psu.edu/it/training/bestpractices/logoffnightly.

RECOMMENDATION: At the end of your work day (Monday — Thursday) log-off your computer. NOTE: You
may choose to Shutdown if storms are threatening your area or over weekends.

Shutting Down

Shutting down your computer closes all programs, disconnects it from the network and powers it down.
You should shut down your computer periodically, but not every day. Shutting down your computer at
the end of your work day Monday — Thursday would prevent your backup from running.

RECOMMENDATION: At the end of your work day on Friday, shut down your computer.
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Recommendations Checklist

Daily (End of work day Monday — Thursday)

v Log-off your computer
Weekly

v' Empty Outlook's Deleted Items folder

v'  Delete the messages in Outlook's Quarantine folder

v' At the end of the work day on Friday, shut down your computer
Monthly

v' Delete items from the Sent Items folder or move to local storage
Quarterly or Bi-Monthly

v" Run Disk Cleanup

v Run Check Disk

v" Run Disk Defragmenter

Semi-Annually

v" Change your Penn State, FPS, and College of Ag Sciences password
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